What’s new in Solid Edge
## Contents

<table>
<thead>
<tr>
<th>Proprietary and restricted rights notice</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>What's New in Solid Edge ST5</strong></td>
<td>1-1</td>
</tr>
<tr>
<td>Part and sheet metal enhancements</td>
<td>1-9</td>
</tr>
<tr>
<td>Assembly enhancements</td>
<td>1-14</td>
</tr>
<tr>
<td>PMI enhancements</td>
<td>1-21</td>
</tr>
<tr>
<td>Sketching enhancements</td>
<td>1-24</td>
</tr>
<tr>
<td>New in Solid Edge Simulation</td>
<td>1-26</td>
</tr>
<tr>
<td>Document management enhancements</td>
<td>1-36</td>
</tr>
<tr>
<td>Draft enhancements</td>
<td>1-46</td>
</tr>
<tr>
<td>User interface enhancements</td>
<td>1-73</td>
</tr>
<tr>
<td>Translator and converter enhancements</td>
<td>1-75</td>
</tr>
<tr>
<td>Administering Solid Edge</td>
<td>1-76</td>
</tr>
<tr>
<td>User assistance tools</td>
<td>1-77</td>
</tr>
</tbody>
</table>
Chapter

1  What’s New in Solid Edge ST5

ST5 is now faster and has more synchronous technology integrated throughout the product. More than 1,300 productivity enhancements requested by our customers are included in this release.

Here are the highlights:

Document management highlights

This release introduces a new document management application, Solid Edge Insight XT.

Insight XT is a SharePoint application with a graphical user interface for managing Solid Edge files and related design information. It retrieves information, lets you visualize complex data relationships, and provides out-of-the-box workflows for Engineering Change Requests (ECRs) and Engineering Change Orders (ECOs).

SharePoint supports customer specific processes and industry regulated processes. See Document management enhancements for more details as well as the enhancements to Solid Edge Embedded Client and Insight.

Administration highlights

Solid Edge offers three product data management integration solutions. Each is packaged independently. When you install Solid Edge, also install the product that matches your license.

To learn more, see Administering Solid Edge.
Part and sheet metal highlights

Solid Edge part and sheet metal enhancements include:

- Slot features

- Multi-body modeling, where you can design many separate models in the same space. With this design method, you can import assemblies into a single part file, merge or split parts, add new parts, and publish individual files for drawing production.

- Solution Manager, an optional tool that you can use during synchronous operations to identify, and graphically control, all affected model relationships.

- Hole recognition, in which holes in imported models become editable hole features in Solid Edge with the new Hole Recognition command. Also, new hole placement options in the synchronous environment include locking to a plane, referencing a midpoint, or referencing another hole.

To learn more, see Part and sheet metal enhancements.

Assembly highlights

More direct part and sheet metal operations are available from the assembly design, including creating, deleting, inserting, and editing features and parts.

- Part replacement provides a variety of ways to adapt old designs for new uses. This includes replacement with a standard part, a new part, or a copy.

- Assembly relationships now include cam, rigid set, and path, as well as connections between faces and keypoints of arcs, cones, spheres, lines, axes, and points.
<table>
<thead>
<tr>
<th>New assembly relationship</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cam</td>
<td>Barrel cam</td>
</tr>
<tr>
<td>Rigid Set</td>
<td>Fixed-position parts</td>
</tr>
<tr>
<td>Path</td>
<td>Slot path</td>
</tr>
</tbody>
</table>
Chapter 1  What’s New in Solid Edge ST5

<table>
<thead>
<tr>
<th>New assembly relationship</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect</td>
<td>Connect faces to any keypoint</td>
</tr>
</tbody>
</table>

- Use site survey data to create large-scale terrain models for positioning buildings and equipment.

- Pipes, frames, and curves have new graphic handles and edit commands to facilitate changes.

To learn more, see Assembly enhancements.

Draft and PMI highlights

ST5 continues to simplify drawing documentation and improve the usability of dimensions and annotations in model PMI and on drawings. This includes:

- Nailboard drawings—Production ready drawings for manufacturing 3D wire harnesses and for high volume products with wiring. The start-to-finish process includes 3D wire harness design, flattening the 3D model into a 2D drawing, adjusting wire paths, and adding conductor tables, connector tables, and wire annotations.
Tip
Try the new self-paced training course, spse01697, Working with nailboards.

- Enhanced flexibility and behavior of annotations and dimensions in PMI and on drawings.

**PMI model dimension enhancements**

- Symmetric dimension edit
- Intelligent dimensions on sheet metal bends

**General dimension enhancements**

- New formatting and positioning options for class fit dimensions, dual unit dimensions, radial and diameter dimensions, and chamfer dimensions.
- Reusable dimension axis for fixing rebind failures after a drawing view update.
- Enhancements to primary and secondary units, including secondary round-off options and new tolerance unit values.
- Dimension and annotation alignment improvements using the mouse, break points, and text.

**Annotation enhancements**

- Text boxes now support Rich Text Format to preserve paragraph styles, indentation, and spacing. New list types include the Latin alphabet and Roman numerals.
- Callouts, balloons, and datum annotations have more snap points, more terminator types, more break line and leader behavior options, and more text management options. New shapes are available for balloons and for datums.
- Weld symbols have an improved interface for defining them in assembly and modifying their properties in draft.

- Table groups, group headings, and group sorting collect and order table items by specified criteria.
- Automatic sheet creation and cleanup for large parts lists quickly expands a top level bill of materials into a multi-sheet atomic parts list.
See Draft enhancements.

**Finite element analysis highlights**

Solid Edge Simulation introduces:

- Steady state heat transfer simulations

- Thermal stress analysis (thermal coupled studies)
See New in Solid Edge Simulation.

**User interface highlights**

New to this release is the Solid Edge Mobile Viewer for the iPad.

See User interface enhancements.

**Online self-paced training**

Access to self-paced training is available online at no charge. Working at your own pace, from your own desktop, you can learn the basics of synchronous part and assembly modeling and drafting with these overviews, animations, and activities.

From within Solid Edge, the link to self-paced training is located on the Help pane. To find it:

1. On the ribbon, click the Help index icon.
2. In the Help pane, under Learning Tools, select Solid Edge Self-Paced Training.
Printable What’s New documentation

A standalone book of What’s New in Solid Edge ST5 is available in the Help pane. To find it:

1. On the ribbon, click the Help index icon.

2. In the Help pane, under Solid Edge Help, select What’s New.

You can print the entire What’s New help book, a selected book, or individual topics.

- To print the full What’s New book, on the Contents page, right-click the topmost book, What’s New in Solid Edge ST5, and then choose Print.

- You can print individual books or topics in What’s New using the same technique.

**Tip**

You can control pagination better by selecting and printing books individually.
Part and sheet metal enhancements

These enhancements were made in the Part and Sheet Metal environments in Solid Edge ST5.

- Web network as a base feature
- Multi-body modeling
- Hole Recognition
- Hole placement techniques (synchronous)
- Thread features (synchronous)
- Solution Manager
- Suspend relationships
- Round edit behavior
- Geometry Inspector enhanced
- Moving ordered chamfer and thread features to synchronous
- New Slot command

Multi-body modeling

Part and sheet metal files now support more than one design body.

Multi-body modeling is a design method which uses more than one solid design body in a single file. In multi-body modeling, you can design many separate models in the same space and according to the same set of rules. This modeling method provides the ability to model many components of an assembly as a single part or sheet metal file. When placing a multi-body part into an assembly, the resulting multiple bodies are represented as a single entry in Assembly Pathfinder and on a bill of materials. An entire assembly could be represented as a single multi-body part. Sometimes the assembly is more important than the actual components that make up the assembly.

Moving ordered chamfer and thread features to synchronous

Equal setback chamfers and external threads can now be moved to synchronous and remain editable as features.

Hole recognition

A new Recognize Holes command detects all hole candidates (circular or conical cutouts) and converts them to hole features. When you select a design body, all hole candidates that are found display in the Hole Recognition dialog box. Similar holes are grouped together. You can use the dialog box to control the type of hole to convert to, and also to specify which found holes to convert.
To learn more, see Hole recognition.

**Web network as a base feature**

The Web Network command now can be used as the base feature of a design model, allowing thin base features. In previous Solid Edge versions web networks required existing model geometry.

**Hole placement techniques (synchronous)**

New hole placement techniques are available in the synchronous environment.

- **Lock to plane**
  When you place two hole occurrences on the same face within the same instance of the command, the plane automatically locks. All later occurrences lock to the plane until overridden by the user.

- **Midpoint reference**
  Aligns a hole with the midpoint of an edge. You can use the $M$ key to align the hole with the midpoint on the highlighted edge. Upon hole placement, a horizontal/vertical relationship is created. You can no longer dimension to the midpoint of an edge.

- **Hole as a reference**
  Aligns a hole with the axis of an existing hole. When you pause the cursor over an existing hole, the hole center point highlights. Pressing the $A$ key begins hold alignment. As you move the hole, alignment lines display on the face when the hole position is horizontal or vertical with the existing hole axis.

  You can align the hole on other faces in the model. As you move the hole on other faces, the alignment lines also display. You may need to press the $N$ key to highlight the edge on the face that is parallel to the alignment lines.

  You also can position the hole on a circular face. The alignment lines display on the circular face as you move the hole over the circular face.

To learn more about these and other hole placement options, see Holes (synchronous environment).

**Thread features (synchronous)**

The synchronous Thread command has been enhanced to enable placing a thread feature with a finite extent to both ends of a cylinder. Both ends must be the same nominal diameter thread. A new dynamic edit control has been added to specify the depth at placement.
Solution Manager

Sometimes face relationships produce an over constrained condition. This condition can cause a synchronous edit to fail or provide unexpected results. Solution Manager provides you with more detail and actions regarding the solve of an over constrained condition. Solution Manager is designed to give you the ability to graphically interact with the model to control all relationships relevant to the current solve.

The Solution Manager buttons are on the Live Rules panel.

To learn how to use Solution Manager, see Solution Manager workflow.

**Note**

Solution Manager replaces the Advanced Live Rules.
Suspend relationships

The Suspend Live Rules option now provides more control to assist in synchronous edits. The Suspend button is now three buttons and is in a new location on the Live Rules panel.

You can suspend all Live Rules (1), dimensional relationships (2), and persisted relationships (3).

When you suspend a relationship category, the button changes as shown.

Round edit behavior

When editing a round, the round axis can either float or remain fixed. You can use the Round Edit Behavior shortcut command to select one of the following options:

- Automatic
- Fix Axis
- Float Axis

The default behavior is Automatic.

To learn more, see Editing rounds.

Geometry Inspector enhanced

The Geometry Inspector has been enhanced to improve the quality of models. A new Heal Body Faults option on the Geometry Inspector dialog box removes faults from the bodies returned by the geometry inspector. This option is only enabled for body constructions or design bodies that do not have dependent features or associative links.

An icon, , is displayed next to any faults returned by the Geometry Inspector that are not valid for healing, along with a description of the problem.
Note

The Heal Body Faults option does not support small entities, so an icon is not displayed next to any small entities returned by the Geometry Inspector.

New Slot command

A new Slot command creates a slot feature along a tangent continuous sketch.

To learn more, see Creating slots.
Assembly enhancements

These enhancements were made in the Assembly environment in Solid Edge ST5. The changes apply to all assembly models.

- Assembly Relationship Enhancements
- Barrel cam assembly relationship
- Insert Assembly Copy
- Large Assembly Modes
- Terrain Modeling Using Virtual Components
- Mirror Assembly Enhancements
- Replace Part Enhancements
- Nailboards (Draft-Wire Harness)
- Inter-Assembly Copy (IAC)
- Geometry Inspector enhanced
- Standard Parts enhanced
- More display configuration control for drawing views
- Piping and frame enhancements
Standard Parts enhanced

Several enhancements have been made to Standard Parts.

- Standard Parts now supports InsightXT. To store your standard parts in InsightXT, run the Standard Parts Configuration Manager and select the Store files in InsightXT option.

- Standard Parts now has a delivery option for Korean Standard (KS) standard parts in the machine library setup.

- Standard Parts now delivers a limited set of DIN and ISO standard valve parts to use in assembly and pipe routes.


- The Custom Setup page in the installation of the Standard Parts Administrator now defaults to Master Part Files, which is the recommended setting for new standard part users. When Master Part Files is selected, additional information for this option is displayed in the Feature Description area on the dialog box.

Assembly relationship enhancements

There are several improvements and additions to assembly relationships.

- Better key point selection.

- Enhancements to axis selection.

- Enhancements to the connect relationship. See the Connect command (Assembly environment).

- Changes to the sketch selection UI for the mate and align commands.

- Tangent relationship processing with zero offset.

- Ability to create a rigid set of assembly components.
  See the Rigid Set command.

- Ability to create a Path relationship.
  See the Path command.

Replace part enhancements

Replace parts in assembly has been enhanced to support the following:

- Replace part (as in previous versions)

- Replace part with standard part

- Replace part with new part

- Replace part with copy
• Replace multiple occurrences—You can select multiple similar or dissimilar parts. The Replace command remains available in all cases.

• Replace in subassemblies—You can select a part in the complete assembly (top-level assembly as well as subassemblies). A part is located first when the cursor hovers over it. If the part is also contained in a subassembly, the subassembly is made available for selection through QuickPick. The selection can also be done from PathFinder.

• Replace All Occurrences—A button on the command bar in the select parts step selects the occurrences to be replaced. The current Select Occurrences dialog box is then converted into a button to extend the selection to ‘All occurrences’ every time the button is clicked. The selections are displayed in the Select color.

To learn more, see Replacing parts in assemblies.

**Mirror assembly components**

The functionality allows the user to Mirror Components in Place about a selected plane.

The plane to mirror the assembly components about must exist prior to using the command.

Components symmetrical about the mirror plane will be rotated and no new occurrence is created for those components.

Components that are non symmetrical about the mirror plane will be mirrored and a new component will be created.

A table showing which assembly components will be rotated and which components will be mirrored is shown prior to command execution.

Shown below is the assembly pathfinder after the mirror operation. Mirrored and rotated components are shown in the red box.

---

**Terrain modeling using Virtual Components**

Digital Terrain Models (DTM) are useful for understanding how buildings and equipment need to be positioned on a building site. Building a solid model of the
terrain using surveying data is beneficial in calculating where earth has to be added or removed to position new construction components.

In the Assembly environment, you can use the Solid Edge Virtual Component Structure Editor to create part documents containing a solid body that represents an extremely large digital terrain model.

To learn about this new capability, see Creating a terrain model using Virtual Components.

**Insert an assembly copy**

The Insert Assembly Copy command inserts the top-level of one assembly into another assembly. All top-level components in the parent assembly are considered top-level components in the child assembly. The command selects top level assembly files only. It does not select parts used in an assembly file.

The result of this operation is that the child assembly has the same top-level occurrence structure as the parent assembly. The parent assembly does not have to be present to display the components once the feature is created. It is needed only for update.

**Large assembly modes**

Assemblies which were considered large several years ago are easily manipulated using current computer hardware. You can easily load an assembly of up to 200 components with all the data available, yet achieve good display quality.
Now you can customize the behavior desired upon opening an assembly file using the Assembly Open As tab (Solid Edge Options dialog box, Assembly environment). Using the parameters listed below, you can specify the assembly file open behavior according to your definition of a small, medium, or large assembly. These settings are defined by the number of unique components.

<table>
<thead>
<tr>
<th>Hide all components</th>
<th>Yes or No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part Activation</td>
<td>Activate All, Inactivate All, Last Saved</td>
</tr>
<tr>
<td>Part Simplification</td>
<td>Use All Designed, Use All Simplified, Last Saved</td>
</tr>
<tr>
<td>Subassembly Simplification</td>
<td>Use All Designed, Use All Simplified, Last Saved</td>
</tr>
<tr>
<td>Activate changed parts on file open</td>
<td>Yes or No</td>
</tr>
</tbody>
</table>

The settings in Solid Edge Options can be applied or overwritten in the Open File dialog box.

**Barrel cam assembly relationship**

Now you can use the Cam command to easily model a barrel cam. The cam relationship allows follower geometry to follow chained curves, such as sketch geometry wrapped around a cylinder.

Characteristics of the chain of curves geometry are:

- Can be open or closed.
- Can be a 3D path and contain splines, arcs, etc.
- The curve must be tangent continuous.
- The edges can be from a sketch, design body, construction curve, or similar. (Assembly sketch is also supported for a 2D Cam.)

Geometric characteristics of the follower surfaces are:

- Cylinders
- Torii
- Spheres (tangent to curve chain)
- The face can be from the design body or any construction body.

**Piping and frame enhancements**

Enhancements have been made to piping and frames.

- The display of handles has been enhanced to make it easier to locate points when editing frames,
• New commands make it easier to edit pipes and frames.
  o The Edit Pipe command edits attributes for the selected pipe.
  o The Edit Fitting command edits attributes for the selected fitting.
  o The Edit Cross Sections command edits the cross section for the selected frame component.
  o The Edit End Conditions command edits the end conditions for the selected frame component.

• A new Extend/Trim option on the Edit End Conditions step of the Frame command bar trims or extends a frame component to a plane, face, or body.
Chapter 1  

What’s New in Solid Edge ST5
PMI enhancements

These enhancements were made to PMI dimensions and annotations in Solid Edge ST5.

Aspect ratio for PMI callout text

Dimensioning to sheet metal bends enhanced

Symmetric dimension edit

PMI exported to NX as real PMI

Aspect ratio for PMI callout text

The following callout text formatting capabilities are available for model PMI callouts in ST5:

- **Aspect ratio**
  Adjusts text size by changing the font width. The height remains constant.

- **Fit to contents**
  Automatically sizes the callout box width to match the PMI callout text width. When the callout border is shown, it changes size along with the text.

- **Fixed—Adjust aspect ratio**
  Maintains the initial PMI callout width by automatically adjusting the aspect ratio as the content gets longer or shorter.

- **Fixed—Wrap text**
  Maintains the initial PMI callout width by wrapping the text onto subsequent lines.

To learn more about these options, see Formatting callout text and border.
**Dimensioning to sheet metal bends enhanced**

The placement dimensions to sheet metal bends is enhanced to take into account the dimension's position relative to a bend and automatically provides the best solutions in QuickPick. The solution can do one of the following:

- Layer face intersection
- Bend silhouette

**Note**

When placing the dimension, you can press I to switch between the different dimension binding options available in QuickPick.

Editing the bend angle updates the bind style between a layer face intersection and a bend silhouette.

The bind point changes dynamically as you change the angle.

**Symmetric dimension edit**

The dimension edit box now contains a symmetric dimension option. When editing the dimension value, the end faces move equal distance from the dimension center.

To learn more, see PMI dimensions and annotations.
PMI exported to NX as real PMI

JT written from Solid Edge can now be imported into NX where it is *real PMI*. There are no changes to JT save options of the associated .ini file. The following PMI object types are supported in ST5:

- Datum Feature Symbol (Datum Frame)
- Surface Finish Symbol
- Datum Target
Sketching enhancements

These enhancements were made to sketching in Solid Edge ST5.

New command: Clean Sketch

Grid enhancements

The grid is available when sketching and drawing in draft and in ordered and synchronous sketch environments. The following usability enhancements were made.

Improved grid function accessibility

These grid options now are available on the command ribbon as well as in the Grid Options dialog box:

- Show Grid
- Snap to Grid
- XY Key-in

Grid shortcut keys

You can use the following shortcut keys while working with grids:
What's New in Solid Edge ST5

<table>
<thead>
<tr>
<th>You can do this</th>
<th>Using these shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reposition grid to current cursor position.</td>
<td>F8</td>
</tr>
<tr>
<td>Turn snap-to-grid on and off.</td>
<td>F9</td>
</tr>
<tr>
<td>Reset the grid origin point to zero.</td>
<td>F12</td>
</tr>
<tr>
<td>Displays the X and Y coordinate input boxes, with the cursor in the X box.</td>
<td>Alt+X</td>
</tr>
<tr>
<td>Displays the X and Y coordinate input boxes, with the cursor in the Y box.</td>
<td>Alt+Y</td>
</tr>
</tbody>
</table>

To learn about these and other grid options, see the help topic, Working with grids:

**New command: Clean Sketch**

You can use the new Clean Sketch command to remove redundant, overlapping, or unwanted 2D geometry elements from a sketch.

The Clean Sketch command is available for synchronous and ordered sketches, and for drawings. It is located in the Draw group on the Sketching tab or on the Home tab.
New in Solid Edge Simulation

The Solid Edge Simulation application is available for all Solid Edge models. These enhancements were made in ST5.

- Thermal studies
- Coupled studies for thermal stress analysis
- Thermal loads
- Thermal plots
- Combined results for mixed mesh models
- Iso line and iso surface result plots
- Unite Bodies command enhancements
- Total or distributed load option now available
- Mesh size displayed in the user interface
- New option simplifies geometry during meshing
- Targeted results plot processing
- Curved beams now supported for structural frame models

Combined results displayed for mixed mesh models

The Simulation Results environment now provides an improved results display for a model that contains a mix of solids and surfaces or united bodies. These enhancements are displayed for part, sheet metal, and assembly models.
• **Solid plus surface results**

All of the result plots now are displayed on the model at the same time. Previously, you could display the surface results or the solid results, but not both at once.

**Example**

This part, which contains surfaces united with solids using the Unite Bodies command, was meshed with the General Bodies mesh type.

![Image of modeled part](image)

• **Plate thickness**

Plate thickness is applied to surfaces using two new options:

- In the **Mesh dialog box**, you can select the Show surface results option to thicken a surface before meshing the model. This is available for 2D Surface meshes and for Mixed Meshes.

![Image showing plate thickness](image)

- In the **Simulation Results** environment, you can select the Plate Thickness option on the Home tab→Show group→Display Options menu to apply a thickness to the model surface. This makes it easier to visualize results.
• **Node values for plates**

The Plate Thickness display option also affects node values shown by the Minimum and Maximum markers and the Probe command. When the Plate Thickness check box is deselected, these annotations indicate whether a node value is located on the top (Top) or the bottom (Bot) of a surface.

To learn more, see Displaying node data for plates in the Probing analysis results help topic.

**Coupled studies for thermal stress analysis**

Now you can use coupled studies to simulate thermal stress analysis. You can create a coupled study by selecting one of the following new study types in the Create Study dialog box:

- Steady State Heat Transfer + Linear Static
- Steady State Heat Transfer + Linear Buckling

To learn more, see Coupled studies.

**Targeted results plot processing**

You no longer have to process all results before the Simulation Results environment can display them. Use the following check box, which is available in the Create Study (or Modify Study) dialog box and on the Simulation tab (Solid Edge Options dialog box), to limit the results preprocessing performed: Do not process all results after solve (faster).

Using this option:

- Reduces the default size of the results file that is generated and stored.
- Does not limit your ability to select and view other results plots.

Unprocessed plots are listed in gray text in the Simulation tree-view pane. You can use the View command to process and display these plot results on demand.

**Iso Line and Iso Surface contour plots**

In the Simulation Results environment, there are new options available for reviewing the study processing results:

- Two new contour plot styles are available for all study types:
- Iso lines—Iso line contours aid in understanding result value distributions on the surface of your model. You can display iso lines on models with solid bodies and on models with plates that are meshed with a surface mesh.

- Iso surface—You can display iso surfaces on models with elements meshed with a tetrahedral mesh, a mixed mesh, or a surface mesh. Iso surface contours show result distributions inside your model.

• Use the new Iso Contour option on the Home tab→Contour Style group to display all of the iso line or iso surface contours on the model.

• Use the new Dynamic Iso Contour command on the Home tab→Contour Style group for a dynamic walkthrough of each individual iso contour color level with its corresponding result value.

To learn more, see the following help topics:

• Contour styles
• Use dynamic iso contours

Mesh size displayed in the user interface

The current mesh size now is displayed in dialog boxes where user-defined mesh size (the Subjective mesh size) is specified. The mesh size units are the same as those specified for dimensions in the file properties.

Previously, the exact value of the Subjective mesh size was not shown.

Example

When meshing a model, the Subjective mesh size is displayed in the Tetrahedral Mesh dialog box.

New option simplifies geometry during meshing

Geometry with very small faces and edges may produce meshing errors. A new option on the Mesh Size page in the Mesh Options dialog box simplifies sliver geometry during meshing to ensure mesh processing completes.

The check box, Use advanced meshing, is selected by default.

Example

Before—Sliver geometry is visible.
After—Geometry is simplified.

Total or distributed load option now available

When applying a force, bearing, moment, or torque load to multiple entities, you now can distribute the load magnitude proportionally among the selected entities, based on area or length. Previously, the full value was applied automatically to each of the selected entities.

The following changes support the total or distributed load capability:

- When selected, the Total Load button distributes the load value proportionally among selected entities of the same type. It is available on the Loads command bar.
- In the Simulation pane, force, torque, bearing, and moment load labels identify the loads as (Total) or (Per Entity).
- In the graphics window, the load label displays (Total) when the Total Load option is applied.
- The simulation report contains a new Load Distribution column to identify when the results are Total or Per Entity.

Unite Bodies command enhancements

In assembly, part, and sheet metal, the following enhancements were made to the Unite Bodies command:

- You no longer have to create a mid-surface or copy construction geometry before you can use the Unite Bodies command. Instead, you can select the design body and the Unite Bodies command fetches the geometry for you.
- You can select geometry that consists of manifold (non-shared) topology, such as weldment assemblies, without having to define assembly connectors. Previously, you could only select geometry with shared edges.
• When creating a study for a model that contains united bodies, use the following mesh types:
  o Mixed and General Bodies (assemblies)
  o General Bodies (part and sheet metal)

To learn more, see Assembly best practices for simulation.

**Thermal loads**

A new Thermal Loads group on the Simulation tab contains five thermal loads available for Steady State Heat Transfer thermal studies and thermal stress analysis.

Use the new thermal loads as follows:

• Temperature load—To evaluate temperature distribution when a constant temperature is applied continuously to selected nodes and elements on a model at equilibrium.

• Convection load—To evaluate free convection.

• Radiation load—To evaluate radiation to space or enclosure radiation.

• Heat Flux load—To evaluate heat power, heat generation, or heat transfer in a part, sheet metal, or structural frames model.

• Heat Generation load—To evaluate heat power, heat generation, or heat transfer in an assembly.
Note

Now there are two different temperature loads on the Simulation tab command ribbon.

- In the Thermal Loads group, the Temperature command works on selected entities in thermal studies.

- In the Body Loads group, use the Body Temperature command to apply a single temperature to the entire model in structural studies and in thermal stress analysis (coupled studies). Also use it to provide a required initial temperature for thermal studies with a radiation load.

See the following help topics:

- Thermal studies
- Thermal loads

Thermal studies

In ST5, Solid Edge Simulation introduces thermal studies for part, sheet metal, assembly, and structural frame models. You can use thermal studies for:

- Heat transfer analysis to evaluate temperature distribution. ST5 introduces steady state heat transfer analysis.
  
  To learn more, see the Using steady state heat transfer studies and Thermal studies help topics.

- Thermal stress analysis, which couples heat transfer analysis results with linear static or linear buckling structural analysis.
  
  To learn more, see Coupled studies and Using coupled studies for thermal stress analysis.

The following enhancements are related to thermal studies:

- A new thermal study type—Steady State Heat Transfer—is available in the Create Study dialog box for tetrahedral, surface, mixed, and beam mesh types.

- For thermal stress analysis, which combines thermal analysis with structural analysis, two new coupled study types are available:
  
  o Steady State Heat Transfer + Linear Static

  o Steady State Heat Transfer + Linear Buckling

- Five new Thermal loads are available for steady state heat transfer simulation studies.

- A variety of new material and thermal load properties are available in the Material Table.

- New thermal result plots and contour shading—Iso Line and Iso Surface—are available to display the simulation results.
See the following help topics:

- Thermal studies
- Thermal loads

**Curved beams now supported**

You can now use curved beams in simulations of structural frame models.
What's New in Solid Edge ST5
Document management enhancements

Solid Edge ST5 introduces graphical document management with Solid Edge Insight XT.

Listed below are the enhancements and new features in Solid Edge Embedded Client, Structure Editor, and Insight Connect.

**Solid Edge Embedded Client**

- Software Compatibility
- Support for Teamcenter Classic Variants
- Support for Teamcenter Display Names
- Meta Model compliance
- Naming Rules implemented
- New Teamcenter Preference
- Family of Parts workflow streamlined
- Revisions command streamlined
- Multi-select within Assembly PathFinder
- New Assembly PathFinder shortcut commands
- Analyze Data Preparation tool expanded

**Insight Connect**

- Insight software compatibility
- Microsoft Office 2007 look and feel
- Insight Architecture Changes
- Improved Solid Edge to View and Markup functionality
- Support for Binary Large Object (BLOB) storage
Graphical document management with Insight XT

Insight XT brings together the 3D CAD design capabilities of Solid Edge with Microsoft SharePoint for managing product data.

Managing documents in Insight XT

Using the Insight XT client, you can manage your Solid Edge CAD files and related documents in SharePoint. Insight XT uses an item data model concept and keeps track of multiple versions and revisions of your documents.

Activating Insight XT in Solid Edge

To activate Insight XT, click the Application button, and choose Manage→Insight XT.

**Note**

The command is disabled if there are files open in Solid Edge.

Activating Insight XT enables the Solid Edge features that work with SharePoint. For example, with Insight XT enabled, the Open dialog box displays the contents of your SharePoint site and enables options such as Revision Rule for working with your data.

Typical workflow for managing Solid Edge documents in Insight XT

- Create a new Solid Edge document and save the document to an Insight XT URL managed by SharePoint.

  **Note**

  The default action for a new document is Upload Document. The document is saved to cache and is added to the library, but remains checked out to you.

- Close and save the document, which allows other users to access it.

- Open the document to check it out.

The Upload option loads the file into the managed library, but leaves it checked out to you. The Check In option loads the document into the managed library and makes it available for other users to check out.

To learn more, see these help topics:

- Defining the Insight XT database list
- Adding documents to an Insight XT managed environment

Software Compatibility

Solid Edge Embedded Client ST5 recommends:

- Teamcenter Express v 5.3.1.1 or 9.1
- Teamcenter 8.1.2.3 or 8.3.3.2
• Teamcenter 9.1
  Teamcenter 9.1 introduces native 64-bit application.

Solid Edge Embedded Client ST5 is not supported with:
• Teamcenter 10.0
• Teamcenter 9.0
• Upgrade from Teamcenter 9.0 to any other Teamcenter release.
• Teamcenter 8.2
• Teamcenter 2007.2
• Teamcenter 2007.1
• Teamcenter Engineering
• Any Teamcenter Express version based on any of the above.

The Solid Edge Embedded Client Administrator installation is required for Teamcenter. The Solid Edge Embedded Client Administrator installation kit includes the Solid Edge Overlay Template for each supported Teamcenter release. This template is used by the Teamcenter Environment Manager (TEM) and is required for upgrades to Teamcenter or new installations of Teamcenter. Solid Edge Embedded Client Administrator should be installed on the Teamcenter server.

Revisions command streamlined

The workflow for Revising managed documents is now more streamlined than before. The intermediate Revisions dialog box has been removed and the revision is set on the common property dialog box. You can now set the revision and upload the document using the same dialog box. For specific instructions, see the Revise a document in SEEC help topic.

Family of Parts workflow streamlined

The workflow for creating and publishing family of parts members in SEEC and Insight XT has been streamlined to only require interaction with one common property dialog box. Now, the New Document dialog box is displayed with rows for all new family of parts members. When you assign properties to the new family of parts members and click OK, the master and members are saved to Teamcenter or SharePoint and are checked out to you.

Multi-select within Assembly PathFinder

You now have the ability to multi-select objects within Assembly PathFinder and then run manage commands on the objects selected. For example, when several indirect documents are checked out to you, you can select more than one of the indirect documents and check them in at the same time.

For more information, see the Use multi-select in Assembly PathFinder help topic.
New Teamcenter Preference: SEEC_CreateFormType_SE Draft

A new Teamcenter Preference—SEEC_CreateFormType_SE Draft—is available to create a Form as part of the Create, Save As, and Revise workflows, then attach it to the Solid Edge Dataset for SE Draft.

The new Teamcenter Preference defines the Relation and Form object to create when the Dataset is created.

New Assembly PathFinder shortcut commands

The Assembly PathFinder Manage Tab and shortcut commands now include:

- Upload all
- Check In All
- Check Out All
- Undo Check Out

This brings functionality available from the Application button in managed environments into the PathFinder manage command and shortcut command options.

Insight user interface changes

The user interface for View and Markup and Revision Manager is enhanced with the gadgets and windows functionality of Microsoft Office 2007.

File-level operations

- File level operations—such as opening, saving, managing, printing, and closing—are located on the Application menu. To open it, click the large round button at top-left of the application window.

- The Most Recently Used document list is accessible through the Application button.

Program options

- Access to the Options dialog box, which was previously on the Tools menu, has moved to the Options button at the bottom of the Application menu. The same button is available from the start-up screen, when no document is open.

  The Options dialog box contains the user settings for all aspects of your session, including: views, file locations, and manage functions.

- The Exit command has also moved to the bottom of the Application menu.

Commands

- A horizontal, tabbed command ribbon replaces menus and toolbars. This makes all commands visible and accessible.
Chapter 1  What’s New in Solid Edge ST5

Tip
You can use the Customize Quick Access Toolbar→Minimize The Ribbon command to reduce the real estate occupied by the command ribbon.

• On each tab, functions are organized by group to help you locate them faster. Command locations have changed.

• The following commands are no longer available in View and Markup
  o Rubberband Select
  o Rubber Stamp
  o Flip Horizontal
  o Flip Vertical
  o Align X
  o Align Y
  o Align Z
  o Seek

To learn what the Solid Edge ST5 user interface elements are called and how they are used, see the Help topic, Touring the Insight Connect user interface.

Insight Architecture Changes

Insight Server no longer requires Full Text Search (FTS). As a result, you will notice several changes:

• An additional Microsoft product is required for users of Windows SharePoint Services 3.0 and SharePoint Foundation 2010.
  o Windows SharePoint Services 3.0 users should also load Search Server Express 2008
  o SharePoint Foundation 2010 users should also load Search Server Express 2010

• The Insight Server Start menu no longer displays:
  o Create Insight Full Text Index
  o Insight Server Assistant
  o Restore Insight Full Text Index

Instead, Configure Insight Search is added to assist you with your configuration.

• Searchscope.txt is enhanced to use new syntax to define the list of available SharePoint Search Service Application Names. Additionally, you can define the list of available SharePoint scopes enabling you to deliver the appropriate experience per designer.
• New Solid Edge Options are available to define the default Search environment.
• Free Text is a new search property.
• Several dialog boxes are updated to reflect changes.
  o The Search dialog box has an icon that takes you to the Free Text Search Criteria dialog box. Selecting options in the dialog box creates the proper search syntax for you.
  o The Where Used dialog box is updated to include the SharePoint Search Service Application name and scopes.
• The following additions are made in Solid Edge Administrator:
  o SharePoint URL (root site) for Search Service Application Name
  o SharePoint Search Service Application Name
  o SharePoint Search — SharpPointScope
  o Limit Search to this Search Service Application and Scope

**Improved Solid Edge to View and Markup functionality**

In Solid Edge ST5, the View and Markup command has dual functionality to either send the active document to View and Markup, or display the new Solid Edge to View and Markup Options dialog box.

Clicking the top portion of the Tools—View and Markup button opens your active document in View and Markup. Clicking the bottom portion of the button displays the dialog box containing a list of options that determine what information is passed from Solid Edge to View and Markup. The list of options includes:
• PMI
• Precise geometry
• Visible parts only
• Visible constructions
• Inter-Part copies as constructions
• Document properties
• Coordinate system
The options you choose can be saved as your default settings.

**Support for Teamcenter Classic Variants**

Creating a single generic product structure that is configurable for each different variant of a product is an important manufacturing approach. In ST5, Solid Edge Assembly gives you the capability of using the structure from Teamcenter and only enabling those document references defined by variants. Some of the features of this capability are:

- When you select the item revision in the Open dialog box, the preview associated with the dataset is displayed.
- When you select a variant assembly in the Open dialog box, the Variant Rule list is accessible and populated with variant rules defined in Teamcenter.
- Assembly PathFinder displays both the Revision Rule and Variant Rule used when you open a document configured with variants.
- All assemblies that have associated variants open read-only at all levels. The Read Only Assistant indicates a variant assembly is opened and gives you the option to use the Save As command to save the assembly to a new item.

**Note**

This project is not intended to provide a method to migrate Solid Edge Family of Assemblies to Teamcenter Variants.

**Support for Teamcenter Display Names**

When Solid Edge transacts data with Teamcenter, it uses a name that is unaffected by localization. This is referred to as the real name. The real name has also been used for the display of the object’s name in the user interface. (Example: Color) However, with the introduction of Teamcenter 8.3, the new BMIDE templates require a unique prefix for each name. The prefix is added to all new business objects to guarantee uniqueness. (Example: SE99_Color). The resulting name is often not desirable for display in the user interface.

Support for the use of a display name addresses this issue and brings consistency in what you see in Solid Edge when compared to Teamcenter rich client.

Some things to be aware of:

- The object’s display name is used for presentation in the user interface only. Solid Edge continues to interact with Teamcenter using the real property name and real property value.
- There is no change to the process an administrator uses to define the property mapping between Teamcenter and Solid Edge.
- An additional read-only row is displayed in common property dialog boxes for presentation of the displayable property name of mapped properties. In the dialog boxes:
  - The column headers show Solid Edge property names.
  - The first row is a read-only row showing the display name.
The second row provides a description.

The third row displays details for range and interdependent lists of values.

- A new preference, SEEC_Item_Type_DisplayableName, is created to capture the Item Type’s display name. See the Solid Edge Embedded Client’s Administrator’s Guide for information regarding the new preference.

- The existing Teamcenter preference TC_display_real_prop_names determines the presentation of the real property name or displayable name.

- The current column headers on common property dialog boxes, and the Property information on the Open dialog box remain the same for all mandatory properties (Item Type, Item ID, Revision, Dataset Name, Dataset Description, Project ID, and Folder). However, the display name is used for all mapped properties. Column headers for mandatory properties are based on the localized version of Solid Edge you are running.

- There are no changes to the column order of common property dialog boxes. Mandatory properties are followed by meta model properties, and then mapped properties which are displayed in alphabetical order.

- Add to Teamcenter is enhanced to support Item Type display names as input.

- The Teamcenter rich client presents both the Property Display Name and the Property Display Value. With system administrator privileges, you can configure the rich client to display real names by changing your options in the general folder. Once the option is set, you can login to the rich client and see real property names.

**Support for Binary Large Object (BLOB) storage**

Both Insight and Insight XT provide support for external Binary Large Object (BLOB) storage.

SharePoint manages two types of data:
- Structured — metadata
- Unstructured — file data

Often a large portion of data in a SharePoint deployment is unstructured, binary data which can impact SharePoint performance. External BLOB storage is the best solution. It enables the database administrator to store large amounts of unstructured data externally rather than directly on the SQL server.

The following storage solutions have been tested with Solid Edge ST5 and SharePoint 2010:
- Metalogix StoragePoint
  - External BLOB Storage (EBS)
  - Remote BLOB Storage (RBS)
There are no Insight Server or Solid Edge configuration requirements with Metalogix StoragePoint.

Note
For additional information regarding Metalogix solutions, go to http://www.metalogix.com/Home.aspx.

Support for naming rules and revision naming rules

Naming rules define the data entry format for a business object property when the new object is created, for example, creating a new Revision (Revise) or copying an existing Item.

A revision naming rule is a business rule that defines the naming convention and sequence for a revision property.

Naming rules consist of two components: a pattern and a counter. The pattern is a variable that defines the format (Example: NNNNN), and the counter is used to define the increment each time it is used.

For the ST5 release, naming rules are implemented as follows:

- Naming rules applied to the Item ID.
- Naming rules applied to the Revision.
- Naming rules applied to the Item Name.
- Revision Naming Rules

See the Naming rules and revision naming rules help topic for additional information.

Analyze data preparation tool expanded

When you start the analyze data preparation tool, you now have the option of selecting the type of data you plan to analyze.

You can choose from:

- Teamcenter
- Insight XT
- Unmanaged or Insight

Additionally, the data analysis spreadsheet has specific tabs corresponding to the type of data you plan to analyze.

See Perform a Solid Edge file analysis help topic for additional information.

Meta model compliance

Meta model compliant applications are capable of discovering the properties required to create an object, obtaining the property information, then submitting that information back to the application requiring the information. In the case of
Solid Edge, in the Teamcenter managed environment Teamcenter can mandate that certain properties are required at the time of the object’s creation. Solid Edge queries Teamcenter to determine these requirements and lets you enter the values so the object is created. The properties are only shown at the time of the object’s creation and they are not saved in the Solid Edge CAD files.

The objects where the meta model can be used are:

- Item
- Item Revision
- Item Master Form and Custom Master Form
- Item Revision Master Form and Custom Item Revision Master Form

Common property dialog boxes are modified to show you the properties delivered with Solid Edge along with meta model properties and mapped properties. When a document is created, the eight properties delivered with Solid Edge are shown first in the New Document dialog box, followed by the meta model properties and the mapped properties. After the new object is created, only the mandatory and mapped properties are shown in common property dialog boxes.

**Note**

There is no requirement to define a mapping to a meta model property that is marked as required, regardless of an initial value.

See the Meta model help topic for additional information.

**Insight Software Compatibility**

Solid Edge ST5 recommends:

- Microsoft Windows Server 2008 or 2008 R2
- Microsoft SQL Server 2008, 2008 R2, or 2012
- Microsoft SharePoint 2007 or 2010

Be sure to check the release notes for details.
Draft enhancements

These enhancements were made in the Draft environment in Solid Edge ST5.

- Alternate assembly drawing views
- Balloon enhancements
- Class fit dimension enhancements
- Dimension enhancements
- Datum annotation enhancements
- Drawing sheet tab color and numbers
- Enhanced workflow for placing multiple drawing views
- Fastener system stacked balloon enhancements
- Grid enhancements
- Independent weld bead hatch and fill options
- Layers, groups, and blocks enhancements
- Multi-body display in drawing views
- More display configuration control for drawing views
- Nailboards support wire harness assemblies
- New alignment options for annotations and dimensions
New command: Clean Sketch

New hatch controls in section views

Parts list and table enhancements

Sheet saving and printing enhancements

Table groups

Text box enhancements

 Unblock All and Ungroup All commands

 Weld symbol enhancements

 View annotations are shown during move

Alternate position assembly drawing views

Now you can use the View Wizard command to create a single drawing view that shows the alternate positions of the same parts within an alternate position assembly. Previously, you had to create multiple drawing views and then overlay them to achieve this result.

• A new page—Drawing View Creation Wizard (Alternate Position Assembly)—is displayed for you to choose the members to display. The purpose of this page is to specify one member to show in the primary position and to select other members to show in alternate positions.

• On the Display tab (Drawing View Properties dialog box), you can use the new Alternate positions list, combined with the Parts list, to change the display properties of individual parts for each position of the members in the drawing view.

• You can apply grayscale, model colors, or shading to the primary member in the drawing view using the Shading and Color tab (Drawing View Properties dialog box).

Balloon and callout enhancements

The following enhancements are provided for balloons and for callouts in Draft and in PMI.
More annotation snap points
Balloons and callouts have more snap points, which you can use to change the attachment point of the leader or the break line to the annotation. The snap points are displayed when you use Alt+drag to move the break line connection point (or the leader line connection point, if there is no break line).

Example

![Diagram of annotation with snap points]

Improved break line and leader behavior
• When break lines and leader lines are turned on and off, the annotation position and the annotation connection point are maintained.

• The leader line is trimmed to the edge of the annotation shape, unless it is connected to its center point.

• The default alignment of break lines to balloons is horizontal and vertical when the balloon angle is zero degrees.

• When you change the balloon shape, the break line orientation does not change. Instead, the break line (or leader line) reconnects to the nearest available snap point on the new shape.

• You can use Alt+drag to adjust the break lines and leaders on stacked balloons so that they do not cross the annotation.

New balloon shape: Rectangle

The Rectangle balloon shape adjusts its width automatically based on the text in the balloon.

The horizontal gap between the border and the text is governed by the Text clearance gap option on the Spacing tab (Dimension Style and Dimension Properties). The vertical gap between the border and text is based on the text height and the balloon height.
Adjustable clearance between text and border
Now you can specify the clearance gap between the text and the border in the dimension style for the following annotations:

- A callout without a border.
- A No Shape balloon.

You can use the following options on the Spacing tab (Dimension Style and Dimension Properties):

- Text clearance gap—Sets the horizontal spacing.
- Vertical box gap—Sets the vertical spacing.

Previously, these options applied only to a callout with a visible border.

**Class fit dimension enhancements**

A variety of enhancements were made to class fit dimensions in Draft, PMI and in sketches.

- New tolerance dimension formatting settings are available in the Tolerance Text group on the Text tab in the Dimension Style and Dimension Properties dialog boxes.

  **Hole/Shaft**
  Three separator types are available to specify the layout of class fit hole/shaft dimensions with tolerance.

<table>
<thead>
<tr>
<th>Use these options</th>
<th>To get this layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separator</td>
<td>Vertical</td>
</tr>
<tr>
<td></td>
<td>( \phi \ 60 \ f_6 ) \ H_7 \</td>
</tr>
<tr>
<td>Space</td>
<td>Vertical</td>
</tr>
<tr>
<td></td>
<td>( \phi \ 60 \ f_6 ) \ H_7 \</td>
</tr>
<tr>
<td>Slash</td>
<td>Horizontal</td>
</tr>
<tr>
<td></td>
<td>( \phi \ 60 \ H_7/f_6 )</td>
</tr>
</tbody>
</table>

**Position**
Three vertical tolerance text position options are available.
**Use these options** | **To get this layout**
---|---
Bottom | Tolerance aligned to the bottom of the dimension text.

| 60 | +0.030 | -0.000 |
---|---|---
Center | Tolerance center-aligned with the dimension text.

| 60 | +0.030 | -0.000 |
---|---|---
Top | Tolerance aligned to the top of the dimension text.

| 60 | +0.030 | -0.000 |
---|---|---

Align to
Two options are available to specify how to align the upper tolerance value with the lower tolerance value: by Decimal Point or by Sign.

Use tolerance text size for combined tolerance text values
A new check box specifies that the combined values are displayed using the tolerance text size entered in the Size box.

**Example**

\[ 60 \pm 0.03 \]

- New class fit dimension display options are available when the Dimension Type is set to Class on the Dimension command bar or the Smart Dimension command bar:

<table>
<thead>
<tr>
<th>Fit</th>
<th>60 H7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit, tolerance only</td>
<td>60 +0.030 0</td>
</tr>
<tr>
<td>Fit with tolerance</td>
<td>60 H7 ( +0.030 )</td>
</tr>
<tr>
<td>Fit with limits</td>
<td>60 H7 (60.030 60.000 )</td>
</tr>
<tr>
<td>Fit Hole/Shaft only</td>
<td>60 H7 f6</td>
</tr>
</tbody>
</table>
### Fit Hole/Shaft, tolerance only

<table>
<thead>
<tr>
<th>Ø 60</th>
<th>+0.030</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>-0.030</td>
</tr>
<tr>
<td>-0.049</td>
<td></td>
</tr>
</tbody>
</table>

### Fit Hole/Shaft with tolerance

<table>
<thead>
<tr>
<th>Ø 60</th>
<th>H7 ( +0.030 )</th>
</tr>
</thead>
<tbody>
<tr>
<td>f6</td>
<td>( -0.030 )</td>
</tr>
<tr>
<td>-0.049</td>
<td></td>
</tr>
</tbody>
</table>

### User-defined

(Any user-defined text is valid)

<table>
<thead>
<tr>
<th>Ø 60</th>
<th>Q1 ( abc )</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>( xyz )</td>
</tr>
</tbody>
</table>

---

## Datum annotation enhancements

A variety of enhancements were made to datum frame and datum target annotations in Draft, for PMI, and in sketches.

**Datum frame annotation enhancements**

- On the **Datum Frame command bar**, you can:
  - Specify a rectangular or circular datum frame shape using the Datum Frame Shape option.
  - Type property text in the Text box to generate a subscript for the datum frame text.

**Example**

To produce a datum frame with this subscript:

```
A₁
```

Type this in the Text box: `A%{/ST^1}`

To learn about this and other formatting options, see the help topic, **Format codes to modify property text output**.

**Note**

Alternatively, you can generate datum frame labels with subscripts automatically using the **Specify Annotation Letters dialog box**, which you can find through the Annotation tab in the Solid Edge Options dialog box.
Chapter 1  What’s New in Solid Edge ST5

- Specify a datum frame terminator line thickness and new terminator type—anchor (hollow)—on the Text and Leader tab in the Properties dialog box.

<table>
<thead>
<tr>
<th>Datum frame terminator type</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anchor (filled)</td>
<td>▲</td>
</tr>
<tr>
<td>Anchor (hollow)</td>
<td>△</td>
</tr>
<tr>
<td>Line</td>
<td></td>
</tr>
<tr>
<td>Normal</td>
<td></td>
</tr>
</tbody>
</table>

- Add dashes around the datum frame text on the new General tab (Datum Frame Properties dialog box). Previously, dashes had to be specified in the style.

Datum target enhancements

On the Datum Target command bar, you can:

- Specify that the datum target area scales with the drawing view by selecting the Use drawing view scale option. This option associates the datum area symbol with the drawing view, even when it is moved or scaled.

- Choose a movable datum target symbol. You can drag the break line edit point to reposition the datum target symbol.

- Choose a new datum point type: rectangular area.

<table>
<thead>
<tr>
<th>Datum Point Type</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>Datum point</td>
<td>x</td>
</tr>
<tr>
<td>Datum circular area</td>
<td>◀</td>
</tr>
<tr>
<td>Datum rectangular area</td>
<td>□</td>
</tr>
</tbody>
</table>

- Specify a new datum target terminator type—arrow—on the Text and Leader tab in the Properties dialog box.
### Dimension enhancements

A variety of enhancements were made to dimensions in Draft, PMI, and in sketches.

- **Specifying tolerance**
  
  There now are two tolerance dimension types that you can select from the command bar when you want to specify a tolerance type of dimension.

  - **Tolerance (unit)**

    Use this option when you want to specify a unit tolerance, such as mm or inch, and when you want to apply formatting to the layout and justification of the tolerance values.

    **Example**

    - You can type 1/8, and it converts to .125.
    - For angular tolerance, you can enter numbers in degrees-minutes-seconds.

    You also can type unit tolerance into the text boxes on the dimension command bar, and use the new Upper Tolerance Sign (+) and Lower Tolerance Sign (-) buttons to specify that the values are positive or negative.

    ![Tolerance Units](image)

  - **Tolerance (alpha)**

    Use this option when you want to enter any alphanumeric string for the tolerance value. This is the way the Tolerance option worked previously.

- **Dual unit formatting**

  Now you can display primary and secondary units side by side instead of vertically. You can do this using the following options on the Secondary Units tab (Dimension Style and Dimension Properties):
Chapter 1  What’s New in Solid Edge ST5

- **Position**
  Below primary or Beside primary

- **Justification**
  Left, Center, or Right

- **Specifying round-off**
  Now there are independent round-off settings for primary units and secondary units. Previously, only secondary unit round-off was available.
  You can specify round-off:
  - Using the new **Round-off dialog box**.
  - On the **Units tab** and the **Secondary Units tab** in the Dimension Properties dialog box and the Dimension Style dialog box.

- **Specifying a dimension axis**
  - Now you can select a centerline to define a dimension axis.
  - For easier identification, the dimension axis is highlighted and displayed as a dashed line instead of a solid line.
  - You can redefine an existing dimension axis by clicking the Dimension Axis button again and choosing a different line. Dimensions that were placed using the original dimension axis readjust to the axis you select.
    Previously, the dimension axis could not be changed.
    You can redefine a dimension axis to correct dimension rebind failures when a drawing view is update.

- **Placing chamfer dimensions**
  Now you can place a chamfer dimension using two keypoints.

  **Example**
Previously, you could only place a chamfer dimension by selecting two linear elements.

- New double arrow terminator types are available on the Terminator and Symbol tab (Dimension Style and Dimension Properties).

- **Radial/Diameter dimension shortcut keys**
  Before you click to place a radial or diameter dimension, you can:
  
  - Use the D key to change from a radial dimension to a diameter dimension, and from a diameter dimension to a radial dimension.

  ![Diagram showing change between radial and diameter dimensions]

  - Press the Alt key to add a projection line extension to the dimension.

<table>
<thead>
<tr>
<th>Default appearance</th>
<th>With the Alt key</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Default appearance diagram]</td>
<td>![With the Alt key diagram]</td>
</tr>
</tbody>
</table>

After placing a radial dimension inside an arc or circle, you can drag the edit handle on the extension line to lengthen or shorten it.

- **Diameter half or full display**
  For diameter or symmetric diameter dimensions, you can use the Diameter Half/Full button on the command bar to change the dimension display between half and full.
### Drawing sheet tab color and numbers

Several changes to drawing sheet tabs make it easier to identify individual sheets and to print sheets that contain related information.

- Sheet groups collect similar types of sheets—such as working sheets, background sheets, and table sheets—into groups in the sheet tab tray. Each group is named and numbered separately.

**Example**

When table sheets are produced for different tables, such as two different parts lists, then the table sheets for each parts list are collected into individual groups. The naming convention for the first table sheet group is Table 1:1, Table 1:2, ...; the naming convention for the second table sheet group is Table 2:1, Table 2:2, and so on.

- Sheet tabs in the same sheet group are arranged by alternating colors in the sheet tab tray. You can change the default color of sheet tabs on the Colors tab (Solid Edge Options dialog box).

- Drawing sheet tabs can display the sheet number, sheet name, or both. You can set these options on the View tab, Solid Edge Options dialog box (Draft).

- Sheet tab tooltips display the full sheet number and name.

- Although not a new feature, you can create property text that references the sheet tab name or number and display it in a callout. The help topic, Property Text source list (Source: From Active Document), describes the property text that you can reference in the document.

To learn more, see these sections in the Drawing sheets help topic:

- Sheet tab groups
- Sheet names and numbers
Enhanced workflow for placing multiple drawing views

A workflow enhancement to the View Wizard command and the Principal View command enables you to place multiple drawing views without restarting the command. Now, when you use either command to place a single drawing view, you can:

- Create additional folded views by clicking to the right, left, top, or bottom of the initial or selected view.
- Create pictorial views by clicking diagonally to the top-right, top-left, bottom-right, or bottom-left of the initial or selected view.
- Right-click to end drawing view placement mode.

Fastener system stacked balloon enhancements

Fastener system balloon text editing

- Now you can add or modify the prefix and suffix text of individual balloons in a fastener system balloon stack. Previously, you could only edit all balloons in the stack.

  **Example**

  The item count (1) was deleted from item balloons 9 and 15, without removing the item count from the remaining item balloons.

  ![Example Image]

  - Editing the prefix or suffix in one balloon does not affect your ability to apply prefix or suffix edits to all of the other balloons in the stack when you edit the stack as a unit.
  - You can reset all of the prefix and suffix edits on the balloons in a fastener system stack using a new command on the balloon stack shortcut menu—Clear Overrides. This does not affect formatting and other changes made to the balloon stack.
  - A new option—Parts List Quantity Property Text—inserts %{Parts List Quantity | G} to extract the parts list quantity into the balloon text.
Chapter 1  What’s New in Solid Edge ST5

Example

For underline balloon shapes, which do not have a designated area to display the item count, you can use the Parts List Quantity Property Text option to insert the item count into the Prefix or Suffix of the underline balloon.

This option is available in the following locations:

- Balloon command bar
- General tab (Balloon Properties dialog box)
- Balloon tab (Parts List Properties dialog box)

Balloon stack snap points

When you use Alt+drag to change where a break line or leader line connects to a fastener system balloon stack, more attachment points are available.

Independent weld bead hatch and fill options

Independent hatch and fill display controls are available for cut weld bead faces in section drawing views. For example, you can hatch part faces that are cut, but not display hatching on the weld beads that are also cut.

Previously, the solid fill was applied by default.

- On the Edge Display tab (Solid Edge Options dialog box), you can use two new check boxes to specify the default treatment for cut weld bead faces:
  - Show fill style in sectioned weld beads
  - Solid fill sectioned weld beads

You can clear both check boxes to display the cut weld bead faces with no hatch or fill.
• You can turn the solid fill on and off for a selected drawing view using the Solid fill sectioned weld beads check box on the Annotation tab (Drawing View Properties dialog box).

  o When selected, you can display the cut weld bead faces with the solid fill.

  o When deselected, the faces are displayed using the underlying hatch pattern in the fill style.

Layers, groups, and blocks have been enhanced

Several enhancements have been made to layers, groups and blocks.
• The Show and Hide commands support the selection of multiple groups. If you select multiple groups that are not hidden in the Block Library on the Library tab, the groups are highlighted in the graphics window.

• The Show Only command supports the selection of multiple layers.

• The Ungroup command supports multiple selections of groups.

• The Unblock command supports multiple selections of blocks.

• The name of the active layer appears in bold text, while the name of a hidden layer or group appears in grayed text.

• If you select groups in the graphics window, the related nodes highlight on the Library tab.

• Commands have been added to support the sorting of layers, groups, and blocks. The Sort by Order Created command sorts the elements by the order in which they were created. The Sort by Ascending command sorts the elements alphabetically in ascending (A-Z) order. The Sort by Descending command sorts the elements alphabetically in descending (Z-A) order.

• Commands have been added to enhance the display of nested groups. The Expand command expands the next level of the selected group. The Expand All command expands all levels of the selected group. The Collapse command collapses all levels of the selected group.

• You can change the line color, line type, line width, and block scales for multiple blocks. If the selected blocks have the same color, line type, line width, or block scale, the values for those properties are displayed in the command bar. If any of the values are different, the line color displays a blank color, the line type displays no selection, and the line width and block scales display no value in the command bar.

More display configuration control for drawing views

A new option is available in Draft to give assembly display configurations and PMI model views full control over what is displayed in drawing views. Now you can show surfaces, curves, centerlines, sketches, coordinate systems, and reference planes in a drawing view, in addition to the solid design bodies.

The new option—Include reference, sketch, and construction items—is available in the following locations:

• On the General tab (Solid Edge Options dialog box), to define a document level preference.

• On the Display tab (Drawing View Properties dialog box), to override the display of a selected drawing view.

You can use this option to reduce complexity in a drawing. For example, you can display tube, pipe, or frame centerlines without displaying the solid bodies of the tubes, pipes, or frames.
Multi-body display in drawing views

Now you can use the Drawing View Wizard to create drawing views from part and sheet metal documents containing multi-body models. Previously, only assembly documents could be used to create a drawing view showing multiple bodies.

- When you create a drawing view of a part or sheet metal model that contains multiple design bodies:
  - All design bodies are shown in the drawing view, regardless of their show and hide state in the model.
  - All design bodies are listed by the same name as they are in the part file, or by the Design Body designation.

- You can show and hide individual bodies in the selected drawing view using the options on the Display tab (Drawing View Properties dialog box).

- When you create a drawing view of a part or sheet metal model that does not contain at least one design body or construction body, the drawing view that is created displays the sketches used to create the model.

Previously, an empty drawing view was created.

Nailboards support wire harness assemblies

To document the manufacturing of the 3D Wire Harness, Solid Edge introduces nailboards. Nailboards flatten a 3D harness assembly onto a 2D board, complete with geometry and annotations.

Tip

Try the new online self-paced training course, spse01697, Working with nailboards.
To support nailboards, several commands have been added:

- The Nailboard View command creates a flattened nailboard view of a wire harness.
- The Connector Drawing View command creates a drawing view of the connector associated with a selected branch of the wire harness.
- The Connector Table command creates a nailboard connector table based on harness information from the connector view.
- The Conductor Table command creates a nailboard conductor table.
- The Insert Bend command inserts a bend on the flattened geometry in the nailboard drawing view.

Along with the new commands, enhancements were made to accommodate nailboards:

- Enhancements have been made to the Solid Edge Options dialog box:
  - New Nailboard View and Connector View views have been added to the list on the Drawing View Style page. The Nailboard style has also been added to the Caption tab on the Modify Drawing View Style dialog box, so that you can define the caption for nailboard drawing views that is unique to the view type.
  - Options have been added to the Edge Display page. The Do not show hidden edges in the connector view option controls the display of hidden edges in the connector drawing view. The Print white conductors in option controls the color in which white conductors appear when you print the nailboard view, making it easier to view the conductor.
- Enhanced tooltips display the name of the highlighted flattened geometry for both the line or bend segment.
- A Wiring Harness category has been added to the Values section of the Select Symbols and Values dialog box that contains harness and component codes for several harness properties.

For more information, see the user help topic, Working with nailboards.

**New alignment options for annotations and dimensions**

Several improvements to annotation and dimension alignment are available in Draft, PMI, and in sketches.

- **Aligning annotation and dimension text**

  The Line Up Text command now aligns text for more annotation types. The expanded list includes datum frames, edge condition symbols, feature control frames, surface texture symbols, text boxes, and weld symbols.

- **Aligning leader break points**
Two new options on the Line Up Text command bar align annotations and linear dimensions using their leader break points instead of their text range boxes.

- Vertical Break Point—Aligns the leader break points of the selected elements vertically.
- Horizontal Break Point—Aligns the leader break points of the selected elements horizontally.

**Making dimension lines collinear and concentric**

As you move a linear dimension (A), you can locate another dimension to display a dotted alignment indicator (B). When you release the mouse button, the first dimension snaps into collinear alignment with the second.

You also can use this technique to move a radial dimension so that it snaps into concentric alignment with another radial dimension.

**Aligning annotation terminators with dimension lines**

You can drag the terminator of a datum frame or feature control frame (1), so that it snaps to the dimension line it references (2).
New hatch controls in section views

New options in the Drawing View Properties dialog box are available to change the hatching on cut faces in section views. You can adjust the angle and spacing of the fill style directly. New section views created from modified section views inherit the hatching overrides.

Previously, you could only adjust cut face hatching using the Draw In View command.
• When a section drawing view is selected, you can make interactive adjustments to the hatching on one or more individual part faces using the following new options on the Display tab (Drawing View Properties dialog box):
  o Spacing
  o Angle

• On the Edge Display tab (Solid Edge Options dialog box), you can use the following file level check boxes to specify that the hatch pattern in newly created section views is always differentiated on different part faces:
  o Automatically alternate hatch spacing in section views
  o Automatically alternate hatch angle in section views

• These check boxes are also available in the Drawing View Display Defaults dialog box when you edit a section drawing view. You can use them to override the file level options.

  Note
  You can open this dialog box from the drawing view properties Display tab, using the Drawing View Display Defaults button . Previously, this dialog box was named Part Edge Display Defaults.

Parts list and table enhancements

The following enhancements are available for parts lists and for all tables except hole tables.

Table workflow enhancements

There now are two workflows you can use to place a parts list or table:

Place a table on the active sheet

You can place a table on the active working sheet dynamically or using a predefined origin point. This is the default workflow.

Place a table on automatically created table sheets

You can place a table on table sheets, which are inserted, named, and grouped automatically in the sheet tab tray. You can use this workflow to organize long parts lists or tables into booklets for easier printing. To learn more, see these Help topics:

  • Defining table size and location
  • Create new sheets for tables

New Location tab

When you create table sheets automatically, you can use the following options on the new Location tab in the Properties dialog box to redefine the formatting for the table sheets.
Chapter 1  What’s New in Solid Edge ST5

First sheet
You can choose a different sheet size and background for the first table sheet.

Additional sheets
You can choose the same or a different sheet size and background for all table sheets except the first one.

Show sheet backgrounds
You can choose not to display the sheet backgrounds on the table sheets. When you use this check box, only the sheet size is applied.

Maintain sheets with table size
You can use this option to ensure that the table which creates the table sheets also manages the table sheets. When the table grows, new sheets are created; when the table gets smaller or is deleted, the unused sheets are deleted also.

New Groups tab
For all tables, you can use the new Groups tab in the Properties dialog box to assign table data to groups using a column property to group by. You also can define subheadings for each table group.

To learn more about this, see Table groups in What’s New.

Other table enhancements

Predefined table location
You can use the X Origin and Y Origin boxes on the Location tab to define the initial table placement location when a table is placed on the active sheet and when table sheets are created automatically. You also can use this option to change the location of an existing, selected table.

More column headings
Now you can define up to five column header rows for parts lists and tables using the Number of rows option in the following locations, depending upon table type:

- On the Columns tab in the Properties dialog box. (The Columns tab is not available for user-defined tables and family of parts tables.)

- In the Format Column dialog box.

Previously, only two headings were available.

Vertical and horizontal cell merging
Now you can merge adjacent table header cells vertically as well as horizontally using the following options on the Columns tab or in the Format Columns dialog box:

- Merge with next vertical cell—This is a new option.

- Merge with next horizontal cell—Previously, this option was labeled Merge with next header.

End-of-table row padding
Now you can insert empty rows at the end of a table to provide padding between the last row of data and the background sheet border or title block. This ensures
that each **table page** is the same height. You can use this option for tables that add rows at the top or at the bottom.

The new option—Fill the end of the table with blank rows—is available on the **General tab** in the Properties dialog box.

Wrap text in rows and columns
When text exceeds the width of a cell, you can wrap text to a new row rather than truncate the text or change the cell height.

The new check box—Wrap table data cells to new row—is available on the **General tab** in the Properties dialog box.

Minimum text size
When the text aspect ratio in table text and text boxes is reduced to fit the width of the cell or text box border, you can specify a minimum text size to prevent the text from becoming too small.

The new option—Minimum aspect ratio—is available on the **Paragraph tab** when:

- You use the **Text Box Properties dialog box** to modify the properties of a selected text box created with the Text command.
- You use the **Modify Text Style dialog box** to modify the Text style with the Styles command.

Better Auto-Balloon behavior
When you use the Auto-Balloon option to place a parts list, overlapping balloons and crossing leader lines are minimized.

**Sheet saving and printing enhancements**

One or more of the following options are available when saving a document in Adobe Portable Document Format (PDF) or printing a document in the Draft environment:

**Sheets**
You can select individual sheets as well as a range of sheets.

**Use individual sheet sizes**
Each sheet is saved according to the sheet size specified in the Sheet Setup dialog box.

**Include grid display on print**
Prints the drawing grid with the sheet when it is displayed using the Show Grid command.

The following dialog boxes are affected:

- The **PDF Export Options** dialog box, when you select the Save As command.
- The **Print** dialog box, when you select the Print command.
- The **Options** dialog boxes, when you select the Print Drawings command.
Table groups

A new tab in the Properties dialog box for parts lists and tables—the **Groups tab**—can be used to group table data. You can use table groups to keep similar data together on a single **table page**, which otherwise may be scattered among many **table sheets**.

- The properties available for creating groups are listed as column headings on the Data tab, as well as on the Columns tab in model-derived tables.

- These columns can be selected on the Groups tab to group the data into categories of information. Items are included in a group based on a value that matches data in the column selected to group by.

- You can define headings for each group that you create, and you can specify where in the table these headings appear. You can apply bold, italics, and underline text formatting to the headings.

- Table groups can be stored using Saved Settings.

To learn how to use these options, see the following Help topics:

- For an overview, see **Grouping data in tables**.

- To learn how, see **Group data in a table**.

Text box formatting enhancements

New formatting options are available for text boxes and text strings created with the **Text command**. They also are available when:

- You use the **Text Box Properties dialog box** to modify the properties of a selected text box.

- You use the **Modify Text Style dialog box** to modify the Text style with the Styles command.

**New tab in the style**

The **Bullets and Numbering tab** now is available in the text box style.

**New list numbering styles**

The following new list numbering options are available:

- Roman numerals (uppercase)
- Roman numerals (lowercase)
- Latin alphabet (uppercase)
- Latin alphabet (lowercase)

You can select the number style from the **Bullets and Numbering** list on the command bar, as well as using the **Style list** on the Bullets and Numbering tab.
Number justification
You can apply left, right, and center justification to the numbers within a numbered list using the new Justification option on the Bullets and Numbering tab.

Example

<table>
<thead>
<tr>
<th>Left justified numbered list</th>
<th>Center justified numbered list</th>
<th>Right justified numbered list</th>
</tr>
</thead>
<tbody>
<tr>
<td>10. List item</td>
<td>10. List item</td>
<td>10. List item</td>
</tr>
<tr>
<td>11. List item</td>
<td>11. List item</td>
<td>11. List item</td>
</tr>
</tbody>
</table>

Multiple character spacing
In ST5, you can use different character spacing within a single text box when you select the text and then use the Character spacing options on the Paragraph tab in the Text Box Properties dialog box.

New line spacing control
In ST5, each paragraph within a text box can have different line spacing and paragraph spacing. Also, new Line spacing options are available on the Indents and Spacing tab for you to customize spacing between lines:

- At Least
- Exactly
- Multiple

These reference the new At box, where you enter the measurement for the line spacing.

Text aspect ratio
In ST5, you can have different text aspect ratios within a single text box. You can set the aspect ratio for selected text using the Aspect ratio box on the Paragraph tab in the Text Box Properties dialog box.

You also can use a new option—Minimum aspect ratio—to specify that text does not get too small when the text box changes size. This option is available on the Paragraph tab.

Empty text box indicator
Like callouts, when a text box exists but does not contain text, the empty text box indicator is displayed, but it does not print.

To learn how to use these options, see the following help topics:

- Format a text box
- Format a bulleted or numbered list
Unblock All and Ungroup All commands

Two new commands assist users who import large and complex AutoCAD files into Draft. These files often contain many nested block occurrences and nested groups. Before you copy imported geometry to a sketch, you can use the following commands to simplify all nested blocks and groups into lower level geometry:

- Unblock All command
- Ungroup All command

These commands are located in the Blocks group and on the shortcut menu. You can use the Undo command to restore the nested geometry if you do not like the results.

View annotations are shown during move

When you move a view annotation by dragging it, the full view annotation is displayed instead of a simplified outline representing its boundary. This applies to:

- Drawing view captions
- Detail envelopes
- Cutting plane lines and labels
- Auxiliary view plane lines and labels

Weld symbol enhancements

Weld symbol enhancements in ST5 are available in the options dialog box for fillet welds, groove welds, and label welds in the Assembly environment, and in the properties dialog box for weld symbol annotations in the Draft environment, in sketches, and in PMI. The changes include the following:

- An improved user interface for defining weld symbol content for ANSI/ISO/DIN weld symbols.
• An improved user interface for defining weld symbol content for GOST weld symbols.

• A new option on the **Text and Leader tab** in the Weld Symbol Properties dialog box—Symbol line width—specifies a different line width for the weld symbol than for the reference line. This option is available for weld symbols that conform to the GB standard.
A new option on the Spacing tab in the Dimension Style dialog box—Three-sided weld symbol offset gap—adjusts the offset between the base of the symbol and the reference line. This option is available for weld symbols that conform to the GB standard.
User interface enhancements

These enhancements were made to the user interface in Solid Edge ST5.

- Solid Edge Mobile Viewer
- Solid Edge Options enhancements
- Favorites are added to all Look-In lists

Solid Edge Mobile Viewer

Introducing the Solid Edge Mobile Viewer, an application for viewing Solid Edge models on mobile viewing devices, such as the iPad.

You can save your Solid Edge part, sheet metal, and assembly models in the lightweight Solid Edge Viewer file format (with an .sev extension), using either of these commands:

- Save As
- Save for Tablet

To learn more, see these help topics:

- Solid Edge Mobile Viewer application.
- Using the Mobile Viewer

Solid Edge Options enhancements

Choices on the Solid Edge Options pages are now determined by your environment at startup: unmanaged Solid Edge, Insight-managed Solid Edge, Teamcenter-managed Solid Edge (SEEC), or Insight XT-managed Solid Edge. Once the environment is determined, the options on the Manage page and File Locations page are displayed.
to match your environment. For example, Solid Edge Options that are unique to SEEC would not be displayed in a non-SEEC environment.

For all environments, the Document Name Formula is moved to the Helpers tab of the Solid Edge Options dialog box. Also, the check boxes in the Manage page under *When closing managed documents* are now radio buttons. As a result, you no longer have the option to leave documents checked out in the cache.

**Favorites are added to all Look-In lists**

Favorites are now available as an option in all Look-In lists when you browse for a folder location. For example, the Open dialog box now includes a Favorites entry in the Look-In list.
Translator and converter enhancements

These enhancements were made to translators and converters in Solid Edge ST5.

- 3D translation logging process enhanced
- Export Draft sheets to separate files
- New Optimize command now available

3D translation logging process enhanced

Enhancements have been made to the 3D translation logging process.

- During import or export of 3D data, either with logging enabled or disabled, a single progress dialog box displays the progress of the translation along with feedback describing the state of the translation progress. Previously, if logging was enabled, in addition to the progress dialog box, the feedback describing the state of the translation progress was displayed in a separate dialog box.

- When logging is enabled during translation, a log file is created on disk.

Export Draft sheets to separate files

A new All sheets to separate files option has been added to the Solid Edge to AutoCAD Translation Wizard (Model Space Scaling) dialog box. You can use this option to export a multi-sheet draft file as individual AutoCAD model space .dxf or .dwg files. During export, the background sheet and working sheet contents are merged with the Solid Edge model view content and exported to AutoCAD model space. Scaling to the exported file is applied based on the selected Model Space Scaling option.

A separate file is created on disk for each Solid Edge sheet. The sheet name is appended to the file name. For example: For example, if the file drawing1.dft contains three sheets the following files are created on disk:

- drawing1_sheet1.dxf
- drawing1_sheet2.dxf
- drawing1_sheet3.dxf

Note

If there is only one sheet or active sheet, the sheet name is not appended to the file name.

New Optimize command

You can use the new Optimize command to analyze imported data and improve the quality and precision of the model geometry. The command makes these improvements by simplifying b-spline definition, healing edges, and identifying blend-like faces.
Administering Solid Edge

This section of What’s New provides Solid Edge administrators with a quick overview of features of the new release.

Installation

Solid Edge now offers three product document management integration solutions. Each is packaged independently. Choose and install the solution that matches your license.

Each solution is available from the installation DVD as follows:

- Solid Edge Insight Client
- Solid Edge Teamcenter Client (formerly Solid Edge Embedded Client)
- Solid Edge Insight XT Client

Additionally, the Solid Edge Embedded Client Administrator is renamed to Solid Edge Teamcenter Administrator and is available from Disk 3 of the installation media, under 32-bit applications. Use this setup for either 32 or 64-bit installations.

Licensing

For detailed information, you can access the Solid Edge License Management web site at: https://www2.industrysoftware.automation.siemens.com/LicenseManagement/Application. A web key is required to access the site.

Support


Licensing

The License Utility has been enhanced to clarify and simplify the process administering Solid Edge licenses. In particular, licensing the product with activation codes is now much easier.

For detailed information, you can access the Solid Edge License Management web site at: https://www2.industrysoftware.automation.siemens.com/LicenseManagement/Application. A web key is required to access the site.
User assistance tools

- Self-paced training is available online
- Tutorials are available in Solid Edge
- Where is user help?
- Contextual Help

Contextual Help

- You can press F1 whenever you need online Help during a design session.

- You can press Shift+F1 to initiate context help 🤔. When this tool is displayed, you can click a command on the ribbon to display online help. Another way to display this tool is to choose Context Help in the new Help window, under Learning Tools.

Self-paced training is available online

Working at your own pace, from your own desktop, teach yourself the basics of part and assembly modeling, and drafting with these overviews, animations, and activities. Work through the self-paced training online or download a course PDF file.

The link to self-paced training is located on the Help pane. To find it:

1. On the ribbon, click the Help index icon 📚.
2. In the Help pane, under Learning Tools, select Solid Edge Self-Paced Training.

Tutorials are available in Solid Edge

The tutorials have been updated for Solid Edge ST5.

The link to tutorials is located on the Help pane. To find it:

1. On the ribbon, click the Help index icon 📚.
2. In the Help pane, under Learning Tools, select Solid Edge Tutorials.

Where is user help?

All online user help books, tutorials, training catalogs, and technical support links are located in their own dockable Help window. You can find it by clicking the Help Index button 📚, which is located at top-right on the ribbon.